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Introduction
This document explains the installation and running of NX on supported 64-bit Windows workstations. NX
is not supported on any Windows 32-bit platform. See the Release Notes for operating system
requirements.

Conventions
All references to "Windows" in this manual refer to 64-bit versions of Windows.
Our company name is “Siemens PLM Software”, however, some program names, folder names and some
product kit names may still retain the old UGS company name.
All references to “SPLM Licensing” in this manual refer to Siemens PLM Software SPLM Licensing.
Windows menu items and commands will be written in bold letters.
When presenting a series of choices from a Windows pull-down menu, an arrow →will be used to
represent the series of submenus, (e.g., Start→All Apps→Windows System→File Explorer). If you do not
have the Symbol font installed, or you browse this document on a non-Windows computer, you may see
the registered trademark symbol (®) in place of the arrows.

Basic Windows Techniques
This document may require you to use some basic Windows techniques to perform certain actions. For
example, you may need to use File Explorer to browse disks and folders, or you may need to use the tools
in the Control Panel to check or change some system settings. You can reach the Control Panel folder
either via your Computer This PC icon, or through Start→All apps→Windows System→Control Panel.
Finally, you may need to use the Windows Task Manager to check that certain programs are running
properly. You can display the Task Manager by right clicking in an unoccupied area of the Taskbar and
then choosing Task Manager. If you are not familiar with these techniques, please consult your Windows
documentation or Help.

Document Revisions
January 2019

Initial Release for NX.

March 2019

Added content for update installations with MSP file.

April 2019

Updated content for MSP file installations.

June 2019

Updated content for functional release information and NX Launcher
product.
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Media Contents
NX software is provided on DVD media and via download. Typically, you will run the installation from the
DVD, which may be in a local DVD drive or mapped somewhere on your network. Alternatively, you may
copy the contents of the DVD to a hard disk or download and extract the media contents to a hard disk,
and run the installation from there. The hard disk may be attached to your own computer, or it could be a
network mapped drive.
Any reference to DVD or media in this document refers to either a physical DVD or a hard drive location
where you have copied or extracted the downloaded installation image files.
The NX media contains the following main items:
README File

Gives a brief description of the contents of the media, an
official title and version, and any special instructions.
nx
This is the main NX "BASE & OPTIONS" kit, which contains
the installation program, optional products and
Translators.
nxlauncher
This is the installation folder for the option Siemens NX
Launcher application.
SPLMLicenseServer_v9.1.2_win_setup.exe This is the Licensing installation kit used for NX. This is a
separate kit which includes a separate installation and its
own version numbering. It is only required if installing a
license server on your local machine.
Docs Folder
Contains installation guides, Release Notes and Fixed PR
information.
Note:

NX Documentation is provided on separate media.

Supported Workstations
The NX supported workstations are not listed in this installation manual; the information is frequently
outdated by new vendor offerings and support certifications. For information on NX supported
workstations, consult the Certification link on the Customer Support (GTAC) Web site:
http://www.siemens.com/gtac
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Licensing NX
NX can be licensed in one of two ways:
1. NX can communicate with a license server which has had the SPLM Licensing software installed on it.
The license server is installed separately by the SPLMLicenseServer kit; it is not part of the main NX
installation. It is only required on license server nodes.
Note:

The current SPLM Licensing daemons support NX versions 5.0 thru current but they are not
backward compatible with NX 4.0. For NX 4.0 and prior releases you will require the old
license daemons supplied in NX 4.0. You may run both the old and new servers at the same
time.
2. NX can acquire licensing information directly from a special node locked license file called a
“Standalone Node-Locked License”. In this scenario, no license server is needed, but this does require
access to a file that is encoded either to your machine’s Ethernet address or a hardware key (a.k.a.
dongle device). In this case it is not necessary to install the SPLM Licensing product.

Siemens NX Launcher
The Siemens NX Launcher is an optional standalone application that you can use to launch NX. It provides an
interface in which you can select an NX environment and NX application, and set any necessary connection
options.
The Siemens NX Launcher installation is available on the NX product media or from GTAC download.
Instructions for installation are provided in this document.
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Overview of the Installation Process
The basic steps for installing NX are as follows:

1.
2.
3.
4.
5.

Log onto your workstation with an Administrator account.
Perform pre-installation checks of your Windows system.
Install SPLM Licensing if necessary. {Only required on license server(s)}
Install NX as a new installation.
Install Siemens NX Launcher as a new installation. {Optional product}

The details of this process are described in subsequent sections. If difficulties arise refer to the
Troubleshooting Section at the end of this guide.

Installation Software Integrity
Digital signatures provide for the authenticity of digital content, such as binary files and executables.
Beginning with NX 12, the binary files and executables included with the installation software for
the Siemens PLM software provided for this release have been digitally signed to ensure that the
installation for this product has not been tampered with before delivery.
Verify the digital signatures on files by opening the Properties of a file and noting the Digital Signatures
tab which lists the digital signatures on the file. The details of a signature can be verified by highlighting a
signature in the list and then clicking the Details button. This will allow a verification that the binary files
delivered have digital signatures from Siemens PLM and have not been subject to tampering.
The installation files, executables (*.exe), MSI files (*.msi), cabinet files (*.cab) and MSI transform files
(*.mst), are all digitally signed by Siemens PLM. Some other binary files and executables on the
installation media may be digitally signed by other providers, such as Microsoft.

Release Frequency
Beginning with NX January 2019 release, the frequency of releases will be increased. Most releases after
January 2019 for NX will be distributed as full installations which can be used to install a full, new
installation, or upgrade a previous NX installation (from releases beginning with January 2019).
This installation guide describes the procedure for new installations and upgrade installations. The
upgrade installation will not be available until the next release of NX after the first functional release.

Functional Product Releases
Beginning with the June 2019 release (1872), NX will have functional product releases that will install to a
separate location than the previous functional release (January 2019). Functional releases are releases
where NX Open functionality may change and new prerequisites may be needed to run NX.
Functional releases will be released on a six month cadence and each functional release will have its own
set of monthly release updates for the 5 months following the functional release. Every functional release
will not require new prerequisites if no prerequisite changes are made to allow NX to run properly.
The first functional release of each family will only be released as a full installation on GTAC as there is no
previous release in the same family to which to perform an upgrade only install.
The monthly updates will continue to be released as full installation which can be used to install a full
install without having a previous release of NX installed or an upgrade to an existing NX installation of the
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same functional release family (functional release plus its monthly updates). Patch only installations will
also be made available for each monthly release after a functional so that upgrading from an installed NX
to a following monthly release can be done with a smaller download file and a faster installation process.
It is not required to install the first functional release of each functional release family to install a
subsequent monthly version of NX. For example, if you skip the June and July releases of NX, you can
install the August 2019 release as a full installation to begin using NX at the August version. After
installing the August release, you can then use either full September install or the September update only
installation to upgrade your August product version to the September product version.

NX Start Menu Changes
Beginning with the June 2019 functional release (1872), the Start Menu for NX will use the same folder name
for every functional release, including the January 2019 release (1847). The new Start Menu starting with the
June 2019 release will have new link names which separates different areas of programs into categories. With
Windows 10, there are no sub-folders in the Start Menu so this change is being done to create a structure that
groups different types of programs together so that they can be located similar to how the sub-folders work in
the Windows 7 Start Menu.
Because the same Start Menu folder will be used for all functional releases, this means that only one version of
NX will have a defined start menu icon for its products. Only one version will have links from the Start Menu
even if multiple versions are installed. The last version installed will take control of the Start Menu links. If you
have an 1872 release installed and afterward you install an 1847 series version, including the deferred releases
for continued support of 1847 series, that version will change the Start Menu links for NX and other programs
to point to the 1847 series.
It is recommended that if you will be installing an older version of NX on a machine with an 1872 version, that
you make a copy of the Start Menu links for the current version before installing so that you can replace them
if needed.
The Siemens NX Launcher is being introduced as an optional product to use to launch NX applications from any
version with the ability to pre-configure environments. NX Launcher will create its own Start Menu link
outside of the NX Start Menu. More information on the Siemens NX Launcher is available in the NX Help.
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Preparing for the Installation
Licensing Configuration Decisions
Use the following criteria to help decide if you need to install the SPLM Licensing product on your local
machine.
The SPLM Licensing installation is needed for the following configurations:
•

The local machine will be a license server on your network. It will provide (serve) licenses to itself or
other machines on your network.

•

The local machine is a standalone machine (such as a laptop) that can not receive licenses from another
machine on your network and must serve its own licenses.

The SPLM Licensing installation is not needed for the following configurations:
•

The local machine receives licenses from another machine on your network (i.e. another machine is the
server and the local machine is a license client).

•

The local machine will use “Standalone Licensing” in which NX will acquire licenses directly from a
special “Standalone Node-Locked License” file.
Caution:

The “Standalone Node-Locked License” file is a special type of license file that is node
locked to your machine’s Physical address (a.k.a. MAC address, Ethernet address) or a
hardware key (dongle) ID. It is not the same type of file used by License Servers. A server
license file can not be used for Standalone Licensing.

The license server can be installed with the separate SPLM Licensing installation that is provided on this
media. One license server can serve licenses to many workstations running NX. The Standalone NodeLocked License file will only provide licenses to your local machine running NX.
NX uses the SPLM_LICENSE_SERVER environment variable. NX versions 5.0 thru 8.5, all use the
UGS_LICENSE_SERVER environment variable. NX 4.0 and earlier versions use UGII_LICENSE_FILE variable.
All three variables may exist on systems running concurrent versions. The default TCP socket for
SPLM_LICENSE_SERVER and UGS_LICENSE_SERVER is 28000, instead of 27000 as previously used in NX 4.0
and earlier releases.
For further information on the licensing installation see the guide Installing Siemens PLM License Server
provided on this media.
For further information about specific SPLM Licensing configuration options, please consult the Siemens
PLM Licensing User Guide.

Java Runtime Environment
The Java Runtime Environment (64-bit) for NX is a system prerequisite that must be downloaded and
installed from the Java website: http://www.java.com prior to running NX. {See also Release Notes}.

Check File System
Window NTFS file system is required for NX and all related products. NX will not work correctly on an old
FAT file system. Please consult your Windows documentation or Help for questions on file systems and
disk partitions.
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Check Disk Space
A complete installation of every module of NX requires approximately 16.5 GB of free space on your disk.
When you run the installation program, it will provide an accurate estimate of the space required and
check that you have the required amount of free space on the target disk.
If you wish to check that there is enough free space on the target disk before starting the installation, run
File Explorer and right-click on the disk letter that you wish to use and select Properties.
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Set Up TCP/IP Network Services
TCP/IP services must be set up and configured for your system. To check this, click on Start→All
apps→Windows System→Control Panel→Network and Internet→Network and Sharing Center→Change
Adapter Settings→Right-click Ethernet→Properties. TCP/IP should be displayed as one of the installed
protocols.
NX uses the TCP/IP network protocol to communicate with the license server. Even if the Siemens PLM
License Server is running on the same computer, TCP/IP is still used.
If your computer does not have an Ethernet Card configured, you must install the Microsoft Loopback
Adapter, which is a "virtual" network adapter that will allow your computer to "talk to itself" via TCP/IP.

You may use the ping utility to check that your TCP/IP connection is operational. On the computer
where you will be running NX, open a Command Prompt window, and type
ping <hostname>

where <hostname> is the name of the computer you will be using as your License Server. If the network
connection is working correctly, several lines of diagnostic output will be displayed, indicating the time
required to transmit packets of data.
If the network connection is not working, you will receive an error message. You must be able to ping
your License Server (and vice versa) in order to run NX. For help with the ping utility, please consult your
Windows documentation or Help.

Hardware Security Device
Individual features of a license file may be node locked to an Ethernet card’s physical address or to a
hardware security device, also known as a hardware key or dongle. If individual licenses are node locked
to a hardware key, you must attach the hardware key to the parallel port or USB port of the workstation
using those license features. The Sentinel device driver that communicates with the hardware key must
also be installed on the workstation.
On a node-locked SPLM Licensing client or a Standalone Licensing workstation, the Sentinel driver must be
manually installed. To check the status of the Sentinel driver, see the section titled Security Device Not
Installed.
Note:

The Sentinel driver installation file can be found on the NX Client in the following (default)
installation path:
C:\Program Files\Siemens\NX\UGFLEXLM\sentinel_installer.exe
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Installing NX
Please complete all of the pre-installation procedures from the previous sections before starting the
installation.

Installation Steps
Please use the following instructions to perform the installation:
1. Log onto your workstation, using an account with Administrator privileges.
2. Place the NX DVD into the DVD drive on your system. When the DVD mounts, it will automatically run
the launch program and present the launch screen.
If this "autorun" feature is turned off for your DVD drive, follow the next two steps to start the
launch program.
In File Explorer click on the icon for your DVD drive.
In the top level folder, right-click on the program Launch.exe and select “Run as Administrator”.
3. Select Install NX from the media Launch screen (if available). {A media launch screen may not be
available, or may be disabled on your system}
OR
Using File Explorer, navigate directly to the nx folder on the DVD drive, and right-click on setup.exe
and select “Run as Administrator” to start the setup program.
4. Select the language in which to run the setup.exe program. This will be the user interface language for
the installation program and does not determine the runtime language of NX.
The setup.exe program, in addition to starting the NX installation, will install two prerequisite
software products if the local machine does not already have them or a newer version installed:
-

Microsoft Visual C++ 2017 runtime redistributable

-

Microsoft .NET 4.6.1

If the machine already has both of these software products, the NX installation will start immediately
when running setup.exe.
If the local machine does not have one or both of the prerequisite software products, the setup.exe
will run their installation program(s) from Microsoft to attempt to silently install the products to the
machine. However, depending on your UAC settings, the installers for these products may pop-up a
request to install on the system. You should accept the request so that the prerequisite software is
installed. If you prefer to install the prerequisite software separately before installing NX, you will find
the .NET 4.6.1 installer (NDP461-*.exe) and Visual C++ redistributable installer (vcredist_x64.exe) in
the nx folder with the setup.exe program.
5. At the Welcome dialog, click Next to continue. Clicking on the Cancel button at any time during the
installation will discontinue (and roll back) the installation.
6. Custom Setup – By default all install features are selected for installation to local hard drive, which
is the same as the Typical setup from previous releases. The NX Platform feature is required and
can not be changed to not install. Any of the other Add-on products can be set to install or not
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install to local disk based on the feature selection drop down to the left of the feature name in the
scrolling box. Click on the drop down
1.

and you will be given three options:

Will be installed on local hard drive – select this to install the feature to the destination
path

2.

Entire feature will be installed on local hard drive – same as “Will be installed on local
hard drive” except for the Add-on products selection. For Add-on products, this will allow you
to select all subfeatures to install to local disk without having the set each feature separately.
3.
Entire feature will be unavailable – sets the feature to not install to disk. During
maintenance mode, changing from “Will be installed on local hard drive” to “Entire feature will
be unavailable” will remove files for the feature from your hard drive. Selecting “Entire feature
will be unavailable” on the Add-on products feature will set all subfeatures to be unavailable on
hard drive.
Click the Browse button to change the destination location or accept the default directory path
provided. The installation will create the directory if it does not exist.
7. Licensing - Enter the name of a license server, a list of license servers or a path to a single
“Standalone Node-Locked License” file. The installation will only support (1) of these options.
• Server name(s) are machine(s) that supply licensing information for running NX. This may or
may not include the hostname of your local node (the computer running this installation). The
hostname(s) of the license server(s) should be entered in the form "<port>@<hostname>"
(where <port> is the TCP port on which the Siemens PLM License Server service runs on the
license server; usually this will be 28000).
• License file is a path to a single “Standalone Node-Locked License” file that NX will read to
acquire license information. A “Standalone Node-Locked License” file is a special license file
that is node locked to your machine’s physical address or hardware key ID. It is not the same
type of file used by License Servers. The installation dialog provides a “Browse” button to allow
users to navigate to their license file.
The answer to this dialog will be used to set the SPLM_LICENSE_SERVER environment variable on your
system. This environment variable may be changed at any time by the Administrator. Consult the
Siemens PLM Licensing User Guide for information on more advanced settings such as redundant
servers.
8. Language Selection - Select the runtime language for NX. In the language selection screen you may
choose the language to be used by NX at runtime, to present menus and text. This selection will set
the UGII_LANG environment variable which may be easily changed at a later time or set differently
for different users.
9. Ready to Install - The final dialog is the Setup Confirmation screen. Verify your installation selections
before proceeding to the file copy sequence. To change any settings, use the Back button to navigate
back to the appropriate installation dialog. Click Install to begin the installation.
Upon the completion of the file copy process, the installation procedure will configure NX to run on this
machine. At the conclusion of the installation, NX will be ready to run and selectable from the Start Menu
(shown as Siemens NX->NX in the Start Menu).
The installation automatically generates a log file in the %TEMP% folder. The file is named MSI*.LOG
where * is a series of numbers and characters which make the filename unique in the %TEMP% folder.
After installation, you can view this log file by selecting the “Show the Windows Log” check box before
closing the installation program or opening the file in the %TEMP% folder.
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Installation Feature Contents
Installation features are a combination of different NX folders required for running the product. Some
features have common NX folders. These folders are only installed once and will exist on the system as
long as one of the install features are installed. The Install Feature is the name of the feature you would
use during automated installation. The Displayed Name is the name (will be translated for some
languages) of the install feature that is displayed in the installation program
The NXBIN directory, is created on all platforms at the %UGII_BASE_DIR%\nxbin location during the NX
installation. Executables and libraries from the user selected installed kits are consolidated into the NXBIN
directory during the installation. NXBIN is not listed below as it is a combination of many install folders.
The folders included in each installation feature are:
Install Feature
Required feature(s):
FEAT_NXPLATFORM

Displayed Name

NX Folders

NX Platform

INSTALL, DIAGRAMCORE,
LOCALIZATION, NXASSEMBLY,
NXHUMAN, NXPARTS, NXPLOT,
PVTRANS, REL_INFO, UGFLEXLM, UGII,
UGMANAGER, UGTIPS, UGWEB

Optional install features (Add-on products):
FEAT_AUTOMATION_DESIGNER
Automation Designer
FEAT_AUTOMOTIVE
Automotive

FEAT_DIAGRAMMING
FEAT_DRAFTING
FEAT_MANUFACTURING

Diagramming
Drafting
Manufacturing

FEAT_MANUFACTURING_PLANNING
FEAT_MECHATRONICS
FEAT_NXNASTRAN
FEAT_PROGRAMMING_TOOLS
FEAT_ROUTING
FEAT_SHIP_BUILDING
FEAT_SIMULATION

Manufacturing Planning
Mechatronics Concept
Designer
Simcenter Nastran
Programming Tools
Routing
Ship Building
Simulation

FEAT_STUDIO_RENDER
FEAT_TOOLING_DESIGN

Studio Render
Tooling Design

FEAT_TRANSLATORS

Translators

FEAT_VALIDATION

Validation

AUTOMATION_DESIGNER
UGAUTOMOTIVE, UGWELD,
MOLDWIZARD, STAMPING_TOOLS,
NXREPORTS, TOOLING_BASE, NXJOIN,
DESIGN_TOOLS
DIAGRAMMING
DRAFTING, TDP
CMM_INSPECTION, MACH,
POSTBUILD, PSTUDIO, UNFOLD
MANUFACTURING_PLANNING
MECHATRONICS
NXNASTRAN
UGOPEN, UGOPENPP, UGALLIANCE
ROUTING, CAPITALINTEGRATION
NXSHIP
SIMULATION, MECH, NXCAE_EXTRAS,
UGSTRUCTURES, UGPCBXCHANGE,
UGFPCD
UGSTUDIO, UGPHOTO
UGAUTOMOTIVE, UGWELD,
MOLDWIZARD, STAMPING_TOOLS,
TOOLING_BASE, NXREPORTS,
DESIGN_TOOLS, NXJOIN
CATIAV5, DXFDWG, IGES, NXPROE,
STEP203UG, STEP214UG, UGCATIA,
UGTO2D, UGIMW, TRANSLATORS
NXREPORTS, DESIGN_TOOLS, MPA
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Using the Maintenance Options
After completing an installation, any subsequent executions of setup.exe will present the ‘Maintenance’
screen. This prompt will offer the option to ‘Change’, ‘Repair’ or ‘Remove’ the installation of the product.
The Change option will allow the installer to add or remove installed features of the NX release. For
example if you wish to add a product that was not previously installed, use the Change option to add the
product. The Change option will also allow the installer to change the license server or runtime language
settings
Note:

This option will also uninstall products that are not selected. Any previously installed products
you do not wish to remove must all be re-selected for installation. If they are already installed,
they will not be reinstalled. However, if they are not selected, they will be uninstalled.

The Repair option will attempt to reinstall or correct any files that do not match the original installation.
Note:

This option compares checksums for thousands of NX files so it takes a very long time to
complete.

The Remove option will uninstall the product completely.
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Running NX
Check System Virtual Memory
To set the system virtual memory (paging file size), select Start→ All apps→Windows System→Control
Panel→System→ Advanced system settings→Advanced tab, click on Performance Settings
button→Advanced tab. Under the area labeled Virtual Memory, virtual memory size is displayed. Click the
Change... button to make modifications to disk and memory size selections. In the Virtual Memory dialog,
highlight the disk drive and verify that the drive you selected has enough disk space.
Set the initial sizes to the recommended values: We recommend setting initial size and maximum size to
the same value.
Initial Size (MB): 6144 is the minimum required, but users with large Assemblies may need much more.
Click the Set button. Click OK from the Performance Options window. This will bring up the System
Properties window.
Click OK. Restart your system to allow all changes to take effect.
Note: Virtual memory (paging file size) can be spread across several disks. Input/Output performance
may be improved using this method.

Java Runtime Environment
A Java Runtime Environment is not supplied with NX. It is a system prerequisite that must be downloaded
and installed from the Java website: http://www.java.com prior to running NX. {See also Release Notes}.

Running NX from the Start Menu
The NX installation program creates a new item in the Programs section of your Start Menu:
To run NX, choose:
Start→All apps→Siemens NX→NX
The NX splash screen will appear, followed by the NX window. Startup should take somewhere between a
few seconds and a couple of minutes, depending on the speed of your computer and your network. If it
takes longer than this, you should consult Troubleshooting to try to diagnose the problem.

Running NX by Double-Clicking
You can also run NX by double-clicking on an NX part (.prt) file.
The NX installation option will establish a filename association between part files and the latest version of
NX installed. Double-clicking a .prt file should work correctly unless the association has been changed by
other applications or removed by an uninstallation of (another version of) NX. The cleanest and fastest
way to reestablish this filename association is to:
1. Uninstall desired version of NX
2. Reinstall desired version of NX
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Running Multiple Versions of NX
The following section no longer applies to NX as a requirement to have two functional releases side-by-side as
functional releases will be released having separate installation locations. This information describes how to
run the administrative installation of the product to set up a separate installation environment.
This information can still be used to install a monthly release to a functional release in a separate location for
testing, if desired, before installing the monthly release as an upgrade to the existing functional release series.
Running multiple versions of NX with the following method is supported for versions prior to January 2019 and
one version of each functional release series of NX after January 2019. To run multiple versions of NX within a
functional release series released after January 2019, see the Installing NX for Parallel Product Testing section.
To provide the ability to run several versions of NX on a single system, do the following:
1. Install all of the desired NX versions on the system, using instructions in the Installation Guide for
the appropriate version. The install procedures will create a different entry on your Start Menu
for each version. You should install multiple versions in the order of oldest to latest. For
instance; install the oldest Base & Options, then any Maintenance Release (a.k.a. MR) for that
base release. Then install the next higher version in that order, finally ending with the latest
release or last MR.
2. If you are running multiple versions of NX, which include versions prior to NX 5.0, you will require
both the NX 4.0 and the current NX versions of the license file and service. The license file and
service installed with NX support 5.0 through current, but they are not backward compatible with
NX 4.0 and earlier versions.
Note: To run NX 4.0 or earlier, you must continue to run the NX 4.0 (uglmd) service.

Automatic Installation of NX
The installation of NX can also be accomplished by an automatic, unattended install. This feature may aid
those System Administrators with a large number of site installations.
Caution:

Use of this type of installation is intended for experienced installers only.

The setup.exe program installs the two prerequisite software products for NX prior to installing NX. It is
recommended that the setup.exe program be used to run the automatic installation to install the prerequisite
software or install the prerequisite software using their installation programs prior to performing the
automatic installation of NX.
The setup.exe program is used to launch the unattended installation in addition to running unattended
installations of the prerequisite software. Command line switches for setup.exe are used to pass values to
the msiexec.exe program.
The unattended installation is controlled by the Windows system component, msiexec.exe. In order to
install silently you must pass switches and NX specific configurable properties to msiexec.exe on the
command line. The msiexec.exe program has several command line switches. For full documentation on
these switches, see the Microsoft help documentation “Help and Support” for msiexec.
There are a few command line switches for the setup.exe program which can be used:
/h – setup.exe help, lists available switches.
/s – run setup.exe silently without any dialogs.
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/a – perform an administrative installation.
/v – pass parameters to the msiexec.exe program.
/w – setup.exe waits for the msiexec.exe command to complete before closing.
Parameters for msiexec.exe must be immediately following /v and may be optionally wrapped in quotes.
You can pass multiple parameters with one /v option. If any parameters passed require spaces, e.g.
C:\Program Files, you must pass the parameter with escaped quotation marks, e.g. \”C:\Program Files\”.
The parameters passed with the /v option are set to the msiexec.exe program as command line switches.
A few of the commonly used msiexec.exe command line switches are:
/h – msiexec help, will list available switches.
/q – specifies the UI level. /qn+ specifies no dialogs except for the ending “install done” dialog
{recommended}. /qn specifies a silent installation with no dialogs. If this option is used there is no
indication when the install completes, you must use the Task manager to monitor the “msiexec.exe”.
/L – specifies a logfile to be created, and the level of the messages to be written to the logfile {e.g.
msiexec /L*v “logfile”}. This example gives the most verbose log file; see msiexec switches for various log
switch options.
/i - specifies the msi file use for installation {e.g., msiexec.exe /i SiemensNX.msi}.
/x- specifies the msi file use for uninstallation {e.g., msiexec.exe /x SiemensNX.msi}.

The configurable properties for the NX install are:
LICENSESERVER This property sets the value of the NX license server. It will default to the value of
the SPLM_LICENSE_SERVER environment variable (if it is set from a previous
installation) or 28000@<localhost> where <localhost> is your workstation name.
LANGUAGE
This property sets the value of the user interface language for NX. Valid choices are
german, french, spanish, english, italian, japanese, korean, russian, simpl_chinese,
trad_chinese, braz_portuguese, czech, hungarian and polish. The default value of
this property is english.
INSTALLDIR
This property sets the directory where NX will be installed. If not specified this will
default to “C:\Program Files\Siemens\NX”.
ADDLOCAL

This property selects the features to be installed. Using ADDLOCAL=ALL will install
all the features.

TARGETDIR

This property sets the directory where an NX administrative installation will be
placed. This property is for administrative installations only. See Installing NX for
Parallel Product Testing for more information.

If you are doing a full installation then you must specify ADDLOCAL=ALL. If ADDLOCAL is not specified on
the command, it is the same as ADDLOCAL=FEAT_NXPLATFORM only.
The remaining selectable install features for a custom install are:
FEAT_AUTOMATION_DESIGNER
FEAT_AUTOMOTIVE
FEAT_DIAGRAMMING
FEAT_DRAFTING

FEAT_PROGRAMMING_TOOLS
FEAT_ROUTING
FEAT_SHIP_BUILDING
FEAT_SIMULATION
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FEAT_MANUFACTURING_PLANNING
FEAT_MANUFACTURING
FEAT_MECHATRONICS
FEAT_NXNASTRAN

FEAT_STUDIO_RENDER
FEAT_TOOLING_DESIGN
FEAT_TRANSLATORS
FEAT_VALIDATION
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The following are examples of silent installations of NX.
Caution:

The setup.exe examples below may appear on multiple lines because of document
formatting but they must be entered on your computer as one line. Arguments with
embedded spaces must be quoted.

This first example installs NX silently, using a full installation, selecting the runtime language to be French,
setting the license server to 28000@myserver, and using the installation location of F:\Program
Files\Siemens\NX. No dialogs are displayed.
setup.exe /s /v”/qn ADDLOCAL=ALL LANGUAGE=french INSTALLDIR=\"F:\Program Files\Siemens\NX\"
LICENSESERVER=28000@myserver”
This next example installs NX silently selecting three features to be installed. The installation is done to
E:\Program Files\Siemens\NX, the runtime language is defaulted to English, and the license server is
specifically set to 28000@xyz. No dialogs are displayed.
setup.exe /s /v”/qn ADDLOCAL=\"FEAT_NXPLATFORM,FEAT_TRANSLATORS,FEAT_DRAFTING\"
INSTALLDIR=\"E:\Program Files\Siemens\NX\" LICENSESERVER=28000@xyz”
This example installs NX silently. The installation is done to E:\Program Files\Siemens\NX, the runtime
language is defaulted to English, and the license server is specifically set to 28000@xyz. In addition a
verbose (*v) log file is generated to C:\temp\install.log. The “/qn+” switch will cause an ending message
dialog to appear.
setup.exe /s /v”/qn+ /L*v C:\temp\install.log ADDLOCAL=ALL INSTALLDIR=\"E:\Program
Files\Siemens\NX\" LICENSESERVER=28000@xyz”
This example installs NX silently. The installation is done to E:\ Siemens\NX, the runtime language is set
to Japanese, and the license server is specifically set to 28000@abc. The setup.exe wait switch (/w) is
used to keep the setup.exe from closing until the msiexec.exe program completes the installation. Use
the /w option when putting commands in a script where you need to wait until the installation is
complete before performing the next command. At a command prompt, the setup.exe will return to the
command prompt. In a batch script, running setup.exe /w will wait until setup.exe exits before the next
batch command is executed.
setup.exe /s /w /v”/qn ADDLOCAL=ALL LANGUAGE=japanese INSTALLDIR=E:\Siemens\NX
LICENSESERVER=28000@abc”
This last example performs a silent administrative installation of NX to the D:\Admin folder. The
administrative installation requires the TARGETDIR property and not the INSTALLDIR property. No other
properties are used by the administrative installation. See Installing NX for Parallel Product Testing for
more information about using an administrative installation.
setup.exe /s /a /v”/qn TARGETDIR=\"D:\Admin\””
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Installing NX as an Upgrade
The following section applies to monthly updates after the first functional release has been installed. For
example, if you install the June 2019 functional release, then the monthly update in July to that version can be
done as an upgrade installation as shown in this section.

Upgrade Installation Using MSI
To install NX as an upgrade to a previous NX version using the full MSI installation, follow these steps:
1. Log onto your workstation, using an account with Administrator privileges.
2. Place the NX DVD into the DVD drive on your system. When the DVD mounts, it will automatically run
the launch program and present the launch screen.
If this "autorun" feature is turned off for your DVD drive, follow the next two steps to start the
launch program.
In File Explorer click on the icon for your DVD drive.
In the top level folder, right-click on the program Launch.exe and select “Run as Administrator”.
3. Select Install NX from the media Launch screen (if available). {A media launch screen may not be
available, or may be disabled on your system}
OR
Using File Explorer, navigate directly to the nx folder on the DVD drive, and right-click on setup.exe
and select “Run as Administrator” to start the setup program.
4. A dialog stating: “This setup will perform an upgrade of ‘Siemens NX’ Do you want to continue?” will
be shown. Click Yes.
5. At the Welcome dialog, click Next to continue.
6. Click Install to begin to upgrade NX. Clicking on the Cancel button at any time during the installation
will discontinue (and roll back) the installation.

Automatic Installation of NX as an Upgrade Using MSI
The MSI installation of NX as an upgrade can also be accomplished by an automatic, unattended install.
This feature may aid those System Administrators with a large number of site installations.
Caution:

Use of this type of installation is intended for experienced installers only.

Performing an unattended upgrade installation can be done with the command line:
setup.exe /s /v”/qn /L*v C:\temp\upgrade.log REINSTALL=ALL REINSTALLMODE=vomus”
This will update installed files in the NX environment to the new NX version of the files.

Upgrade Installation Using MSP
To install NX as an upgrade to a previous NX version using the patch MSP installation, follow these steps:
1. Log onto your workstation, using an account with Administrator privileges.
2. In File Explorer locate the location to which you saved the downloaded upgrade MSP zip file from GTAC.
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3. Extract the MSP zip file.
4. Double-click on the program setup.exe program in the extracted location to begin the installation.
5. On the Welcome screen, click Next.
6. Click Update to begin to upgrade NX. Clicking on the Cancel button at any time during the installation
will discontinue (and roll back) the installation.

Automatic Installation of NX as an Upgrade Using MSP
The MSP installation of NX as an upgrade can also be accomplished by an automatic, unattended install.
This feature may aid those System Administrators with a large number of site installations.
Caution:

Use of this type of installation is intended for experienced installers only.

Performing an unattended upgrade installation can be done with the command line:
setup.exe /s /v“/qn /L*v C:\temp\upgrade.log”
setup.exe in this command is the setup.exe included with the msp files in the downloaded zip file.
This will update installed files in the NX environment to the new NX version of the files.

Installing NX for Parallel Product Testing
Because the NX installation will upgrade any previously installed version of NX (January 2019 and newer)
you must perform an administrative installation to put a newer version of NX on the system without
upgrading your existing installation.
Note:

This type of installation will not configure NX for execution. It will not modify or add registry
entries or change the SPLM_LICENSE_SERVER and UGII_LANG environment variables.
Installing the administrative installation will allow you to run NX using the same environment
variables as your existing installation but does not affect the settings of the existing
installation.

Note:

This type of installation can not be done into the %SystemDrive%:\Program Files folder.

Administrative (Parallel) Installation
To install NX for parallel product testing follow these steps:
1. Log onto your workstation, using an account with Administrator privileges.
2. Place the NX DVD into the DVD drive on your system. When the DVD mounts, it will automatically run
the launch program and present the launch screen.
If this "autorun" feature is turned off for your DVD drive, follow the next two steps to start the
setup.exe program.
Exit the Launch.exe program if it starts.
3. Using a Command Prompt window, change folder directly to the nx folder on the DVD drive, and run

setup.exe with the command:
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setup.exe /a
4. At the Welcome dialog, click Next to continue. Clicking on the Cancel button at any time during the
installation will discontinue (and roll back) the installation.
5. Network Location – Set the location to put the administrative installation of NX for use in parallel
product testing. Enter a network location in the field or click Change… to select a location.
Click Install to begin the installation.
NX will be put in the following folder structure under the location defined as the network location:
Siemens\NX\[kits] – this is the installed location of the parallel NX on the system
System64 – contains files which would be installed to the system folders if this were a standard
installation, these can be ignored in this environment as these files were previously installed with the
prior complete installation of NX.
The system environment variables UGII_LANG and SPLM_LICENSE_SERVER will remain the same values as they
were when NX was previously installed for the version which is managed by MSI and available on Start menu.
This version can use those same variables when running. The UGII_BASE_DIR environment variable is set to
point to the existing version of NX and not this administrative install version. You MUST set the
UGII_BASE_DIR to point to this administrative version of NX when running.

Upgrading the Parallel Installation with an MSP file
The MSP files provided as an upgrade only installation can be used to update the parallel installation location
with updated files.
Note: The parallel installation must be in the same format that it was originally dumped to disk with the
SiemensNX.msi file at the top level and the Siemens\NX folder still existing. E.g. E:\Parallel was the
original installation location and E:\Parallel\SiemensNX.msi and E:\Parallel\Siemens\NX exist.
To update a parallel installation (administrative install) location with an MSP file, do the following:
1. Log onto your workstation, using an account with Administrator privileges.
2. Open a Command Prompt window and change the folder to the location to where you extracted the
downloaded MSP zip file from GTAC.
3. Update the parallel installation location with the following command. In this example, the parallel
installation is in E:\Parallel and the extracted MSP files are in D:\Downloads. The below command line
is all one line, not separate lines.
Note: The names of the MSP files will be the names created during the extraction of the zip file.
msiexec.exe /a E:\Parallel\SiemensNX.msi /p
D:\Downloads\SiemensNX.msp;D:\Downloads\SiemensNX2.msp;D:\Downloads\SiemensNX3.msp
Include all of the MSP file names in the folder, separated by semi-colons, on the command line.
This will update any changed existing files, add new files, and convert removed files to empty files in the
parallel installation location. This will allow NX to run like it would in a regular installation.
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Running the Parallel Installation (Administrative Install)
To run the parallel installation, you must use a command prompt and run NX at the command line.
1. Open a Command Prompt window.
2. Set the UGII_BASE_DIR variable to point to NX. If the network location of the parallel install was
E:\Parallel, then set UGII_BASE_DIR to E:\Parallel\Siemens\NX.
set UGII_BASE_DIR=E:\Parallel\Siemens\NX
3. Verify the UGII_LANG and SPLM_LICENSE_SERVER variables are as expected.
4. Use set UGII_LANG and set SPLM_LICENSE_SERVER to check the values. Set to new values if needed.
5. Run NX:
”%UGII_BASE_DIR%\nxbin\ugraf.exe” –nx

Removing the Administrative (Parallel) Installation
Since the administrative installation does not create any registry entries or modify environment variables,
to remove the administrative installation you only need to delete the files and folders from the workstation.
Use Windows Explorer and remove all the files and folders under the location used to install the
administrative installation.

Installing Siemens NX Launcher
The Siemens NX Launcher installation is on a separate button on the Launch.exe program.

Siemens NX Launcher Installation Steps
Please use the following instructions to perform the installation:
1. Log onto your workstation, using an account with Administrator privileges.
2. Place the NX DVD into the DVD drive on your system. When the DVD mounts, it will automatically run
the launch program and present the launch screen.
If this "autorun" feature is turned off for your DVD drive, follow the next two steps to start the
launch program.
In File Explorer click on the icon for your DVD drive.
In the top level folder, right-click on the program Launch.exe and select “Run as Administrator”.
3. Select Install NX Launcher from the media Launch screen (if available). {A media launch screen may
not be available, or may be disabled on your system}
OR
Using File Explorer, navigate directly to the nxlauncher folder on the DVD drive, and right-click on
setup.exe and select “Run as Administrator” to start the setup program.
4. At the Welcome dialog, click Next to continue. Clicking on the Cancel button at any time during the
installation will discontinue (and roll back) the installation.
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5. Destination Folder – Enter in or use the Change…. Button to select a location on your workstation
to install the NX Launcher program. Click Next to continue.
6. Ready to Install - The final dialog is the Setup Confirmation screen. Verify your installation location
before proceeding to the file copy sequence. To change the installation location, use the Back button
to navigate back to the appropriate installation dialog. Click Install to begin the installation.
Upon the completion of the file copy process, the installation procedure will configure NX Launcher to run on
this machine. At the conclusion of the installation, NX Launcher will be ready to run and selectable from the
Start Menu (shown as Siemens NX Launcher in the Start Menu).
See the product help document, PDF format, in the doc folder in the NX Launcher installation location for
information on configuring NX Launcher to use multiple programs and environments.

Mapped Drive Installation
The mapped drive installation has been moved to a separate installation program. The mapped drive
installation is used if you have NX installed on a remote disk on your network and you want to configure your
local machine to run the network mapped NX via the Start menu. Mapped drive installation installs the NX
required fonts; configures the registry settings needed for file associations and registered DLLs; creates the
NX environment variables and creates Start menu shortcuts to run NX. You can not create a mapped drive
installation on the same machine that has NX locally installed except for local administrative installations.

Mapped Drive Installation Steps
Please use the following instructions to perform the installation:
1. Log onto your workstation, using an account with Administrator privileges.
2. Place the NX DVD into the DVD drive on your system. When the DVD mounts, it will automatically run
the launch program and present the launch screen.
If this "autorun" feature is turned off for your DVD drive, follow the next two steps to start the
launch program.
In File Explorer click on the icon for your DVD drive.
In the top level folder, right-click on the program Launch.exe and select “Run as Administrator”.
3. Select Mapped Drive Installation from the media Launch screen (if available). {A media launch screen
may not be available, or may be disabled on your system}
OR
Using File Explorer, navigate directly to the mapped folder on the DVD drive, and right-click on
setup.exe and select “Run as Administrator” to start the setup program.
4. Select the language in which to run the setup.exe program. This will be the user interface language for
the installation program and does not determine the runtime language of NX.
The setup.exe program, in addition to starting the NX installation, will install two prerequisite
software products if the local machine does not already have them or a newer version installed:
-

Microsoft Visual C++ 2017 runtime redistributable
Microsoft .NET 4.6.1

If the machine already has both of these software products, the NX installation will start immediately
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when running setup.exe.
If the local machine does not have one or both of the prerequisite software products, the setup.exe
will run their installation program(s) from Microsoft to attempt to silently install the products to the
machine. However, depending on your UAC settings, the installers for these products may pop-up a
request to install on the system. You should accept the request so that the prerequisite software is
installed. If you prefer to install the prerequisite software separately before installing NX, you will find
the .NET 4.6.1 installer (NDP461-*.exe) and Visual C++ redistributable installer (vcredist_x64.exe) in
the mapped folder with the setup.exe program.
5. At the Welcome dialog, click Next to continue. Clicking on the Cancel button at any time during the
installation will discontinue (and roll back) the installation.
6. Reference Folder – Enter the directory path of the network mapped NX installation
(%UGII_BASE_DIR% folder location). The installation must exist to use it as a reference folder. Click
the Change button to change the reference location.
7. Licensing - Enter the name of a license server, a list of license servers or a path to a single
“Standalone Node-Locked License” file. The installation will only support (1) of these options.
• Server name(s) are machine(s) that supply licensing information for running NX. This may or
may not include the hostname of your local node (the computer running this installation). The
hostname(s) of the license server(s) should be entered in the form "<port>@<hostname>"
(where <port> is the TCP port on which the Siemens PLM License Server service runs on the
license server; usually this will be 28000).
• License file is a path to a single “Standalone Node-Locked License” file that NX will read to
acquire license information. A “Standalone Node-Locked License” file is a special license file
that is node locked to your hardware or hardware key. It is not the same type of file used by
License Servers. The installation dialog provides a “Browse” button to allow users to navigate
to their license file.
The answer to this dialog will be used to set the SPLM_LICENSE_SERVER environment variable on your
system. This environment variable may be changed at any time by the Administrator. Consult the
Siemens PLM Licensing User Guide for information on more advanced settings such as redundant
servers.
8. Language Selection - Select the runtime language for NX. In the language selection screen you may
choose the language to be used by NX at runtime, to present menus and text. This selection will set
the UGII_LANG environment variable which may be easily changed at a later time or set differently
for different users.
9. Ready to Install - The final dialog is the Setup Confirmation screen. Verify your installation selections
before proceeding to the file copy sequence. To change any settings, use the Back button to navigate
back to the appropriate installation dialog. Click Install to begin the installation.
Upon the completion of the file copy process, the installation procedure will configure NX to run on this
machine. At the conclusion of the installation, the mapped drive NX will be ready to run and selectable
from the Start Menu (shown as Siemens NX (Mapped Drive)->NX in the Start Menu).
The installation automatically generates a log file in the %TEMP% folder. The file is named MSI*.LOG
where * is a series of numbers and characters which make the filename unique in the %TEMP% folder.
After installation, you can view this log file by selecting the “Show the Windows Log” check box before
closing the installation program or opening the file in the %TEMP% folder.
The mapped drive installation is named Siemens NX (Mapped Drive) on the local workstation. To
uninstall, remove the Siemens NX (Mapped Drive) product.
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Additional Topics
Uninstalling NX
To remove the NX product:
Windows 7 & 8:
1. Log onto your workstation with an Administrator account.
2. Select Start→Control Panel→Programs and Features
3. Select Siemens NX and then click the Uninstall option.
Windows 10:
1. Open the Start menu.
2. Click Settings.
3. Click System on the Settings menu.
4. Select Apps & features from the left pane.
5. Select Siemens NX and then click the Uninstall option.
6. Click the Uninstall pop-up button to confirm.

Other Uninstall Considerations
•
•

•
•
•

You may also re-run the NX setup program which will offer the option to Remove the installation (i.e.
uninstall).
You may also use msiexec install option “/x” to uninstall NX.
a. Uninstall using msi file: msiexec /x “SiemensNX.msi”
b. Uninstall using Product GUID: msiexec /x {26973E5A-B9DD-474A-9B0D-106149218DDF}
There is no separate “uninstall” program or uninstall shortcut for NX.
It is not necessary to reboot after uninstalling NX.
The Siemens PLM License Server service supplied by the installation of the SPLM Licensing kit or from
a remote server will not be removed by uninstalling NX.
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Changes
This topic provides an overview of significant changes in the installation kits for this release.

Kit Consolidation
Beginning in NX 11, to simplify kit selection at installation time, many kits have been combined into larger
selectable groups in the “Custom” installation selection menu. At the conclusion of the installation the
folder structure will be similar to previous NX versions. For example, a single “Translators” kit selection
now includes all the translators that were previously selectable in prior NX installation.

UGII_ROOT_DIR obsoleted
In NX 11, the %UGII_ROOT_DIR% environment variable was retired.
To find executables and libraries, a central runtime directory called NXBIN is now used.

NXBIN directory
The NXBIN directory, is created on all platforms at the %UGII_BASE_DIR%\nxbin location during the NX
installation. Executables and libraries from the user selected installed kits are consolidated into the NXBIN
directory during the installation.
Configuration and script files that used to be found under %UGII_ROOT_DIR% will now be in
%UGII_BASE_DIR%\ugii. Executables, libraries and jar files that used to be found under
%UGII_ROOT_DIR% will now be in %UGII_BASE_DIR%\nxbin.
While the NX installation no longer sets the UGII_ROOT_DIR variable, the definition on the system will
remain to support earlier releases. If your code or scripts rely on %UGII_ROOT_DIR%, modify them to
ensure they work in NX.
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Troubleshooting
Windows Diagnostic Tools
Windows provides a variety of tools that you can use to understand how your computer is working and
diagnose problems. Some examples are:
Windows System Info

Can be found via Start→All apps→Windows Administrative Tools→System
Information. It provides information about your system, and allows you to print this
information, or save it in a file. You can also run Windows Diagnostics by typing
msinfo32 in a Command Prompt window.

Event Viewer

Provides you with a log showing various low-level events that have occurred while
your system has been running. Again, you can typically access this utility via Start→
All apps→Windows System→Control Panel→Administrative Tools.

System Properties

The System Properties item in Control Panel lets you check and modify the values of
environment variables that affect the behavior of your system. Variables are located
under Start→ All apps→Windows System→Control Panel→ System→Advanced
system settings→Advanced tab→Environment Variables.

Net Commands

Windows provides a wide variety of commands for diagnosing networking problems,
which can affect the system’s ability to communicate with the SPLM Licensing
daemons. For more information, you might start by looking up the ping and netstat
utilities in Windows Help, or type net help in a Command Prompt window.

If you need help with any of these tools, please consult your Windows documentation or Help.

Creating Install Log Files
If the installation does not complete successfully, error logs of the installation may provide helpful
information. In a command prompt window enter:
setup.exe /v“/L*v C:\LogFile2.txt”
{where LogFile2 is the full path to your log file. Note: there is no space after the “/v” switch. This example
shows using “setup.exe” to start the log. Setup actually passes these switches to msiexec.exe}
Note:

The msiexec.exe program supports many levels of log file information from terse start/stop
messages to the very verbose log example shown above. See “Help and Support” on msiexec for
information on the levels of logging available.

NX Won't Start
If NX fails to start, a window will display the reason for the failure.

Can't Connect to License Server
Check that the SPLM Licensing license server is available. Open a Command Prompt window, change to
the %UGII_BASE_DIR%\UGFLEXLM directory and enter the command:

lmutil lmstat –c 28000@<hostname>
{where 28000 is the port number and <hostname> is the hostname of the SPLM license server}

29

For example:
cd /d C:\Program Files\Siemens\NX\UGFLEXLM {default location}
lmutil lmstat -c 28000@<hostname>
{where 28000 is the port number and <hostname> is the hostname of the SPLM license server}
Diagnostic messages will appear telling you some possible sources of your problem.

No Licenses Available
Using the Licensing Tool to Select Bundles
Note:

Prior to NX 9.0, License Options was used to set persistent or default bundle selections via the
UGS_LICENSE_BUNDLE variable that it created. As of NX 9.0, Licensing Tool does not create a
variable but instead, stores the bundle selections in the Registry.

All licenses for module "gateway" are already in use or no bundles have been selected. Your license file
may contain Suite Packages, otherwise known as Bundles and Portfolio Bundles. To use a bundle, it must
be preset prior to running NX. If bundles are preselected, the application will attempt to check out a
bundled feature before trying to check out the floating feature.
Licensing Tool is an interactive user interface that aids in setting persistent or default bundle selections in
the user accessible registry entry:
HKEY_CURRENT_USER\Software\Siemens_PLM_Software\Common_Licensing\NX_BUNDLES
To set the bundle(s) in the registry:
Click on Start→All apps→Siemens NX→Licensing Tool
Caution: Customers using Bundle/Portfolio licenses must either set the bundle selection(s) via the
'UGS_LICENSE_BUNDLE' variable or the ‘NX_BUNDLES’ registry entry with the package
name(s) of the bundle(s) before attempting to run NX. Licensing Tool honors the bundle
selections set by the variable but once Licensing Tool is used to apply a bundle, the
UGS_LICENSE_BUNDLE variable is no longer honored nor effective. If the ‘NX_BUNDLES’
registry entry exists (even if the value is ‘blank’), it would have to be deleted in order to
make the bundle selections effective for the UGS_LICENSE_BUNDLE variable if set.
Consult the Siemens PLM Licensing User Guide for further information
regarding Bundles, crossover licensing, automatic bundle consolidation and
automating the selection of NX Bundle(s)/Portfolio(s).
Checking the Siemens PLM License Server Service {on the server}
Check that the Siemens PLM License Server service is running, either using Task Manager or Control
Panel→Administrative Tools→Services. In Task Manager, you should see entries for lmgrd.exe and
ugslmd.exe. Using Control Panel→Administrative Tools→Services, you should see Siemens PLM License
Server with a status of "Started".
If the service is present, but not running, you should start it manually. Control Panel→Administrative
Tools→Services. Right-click the service name "Siemens PLM License Server", and click Start.
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If the Siemens PLM License Server service is unable to start, there may be other problems. Choose
Start→All apps→Siemens PLM License Server→lmtools. In the Service/License File section, select
"Configuration using Services". Click on the "Config Services" tab. The "Siemens PLM License Server"
service should appear in the Service Name field. Verify that all "path to" entries are valid.
These entries displayed on the lmtools screen should not be blank. If these entries are blank, enter the
correct service name as shown above. Use the browse button to search the drive for the location of the
installed license program (lmgrd.exe). Browse for the correct license file. The default location for the
Debug Log File should be set to C:\Program Files\Siemens\PLMLicenseServer\splm_ugslmd.log, provided
that the directory path is where you installed SPLM Licensing. Use the browse button to update this field.
Make sure the two checkboxes, “Start Server at Power Up” and “Use Services”, are both checked (after
checking “Use Services”, “Start Server at Power Up” will become available). Click the “Save Service”
button.
To start the license service from lmtools, open the Start/Stop/Reread tab. Click the Start button.
Note:

The graphically-oriented license administration utility lmtools is also available on the SPLM
Licensing client if installed. For example:

Click on Start→All apps→Siemens NX→Lmtools
The utility lmutil is a command line license administration tool similar to the graphically-oriented
LMTOOLS utility. Open a Command Prompt window to use this utility and change directory to the
appropriate FLEXlm directory. Run the command:
lmutil lmstat -c 28000@<hostname> –a
{where 28000 is the port number and <hostname> is the hostname of the SPLM license server}
from the server machine to verify that the vendor daemon is alive. Run the same command from a client
machine to verify the connection across the network from client to vendor daemon. Other information
may be extracted using different switches or options; these are documented in the Flexera Software
FlexNet Publisher License Administration Guide.
For example:
cd /d C:\Program Files\Siemens\NX\UGFLEXLM {on a client}
cd /d C:\Program Files\Siemens\PLMLicenseServer {on a server}
lmutil lmstat -c 28000@<hostname> –a
{where 28000 is the default port number and <hostname> is the hostname of the SPLM license
server}
Diagnostic messages will appear telling you some possible sources of your problem.
Some typical responses are:
License File Could Not If you are receiving your license data file via e-mail, you need to save it in text format.
Be Read
Some users using MSWord as their reader may receive garbage in the license file (e.g.
License_Ugslmd.txt) when it is received in e-mail.
See splm_ugslmd.log

When the SPLM License Server service is started, the log file splm_ugslmd.log is
created. The log file can give you the best information on the state of the license
server. This file can be opened with the Notepad editor, and it will give some
indication as to what went wrong. Errors may be a result of a corrupted license file,
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the lmhostid not matching the license file, or networking problems involving TCP/IP or
DNS configuration. Use the instructions given earlier to check that there is a working
TCP/IP network connection to your SPLM License Server. This file is located by default
at:
C:\Program Files\Siemens\PLMLicenseServer\splm_ugslmd.log
This can only be performed from the license server.

Security Device Not Installed
If the Hardware Key is not installed properly or if the Sentinel System Driver is not installed and started,
when a node-locked feature is attempted to be checked out, an error message similar to the following will
be displayed:
FLEXnet Licensing error:

-9

Invalid host
The hostid of this system does not match the hostid
specified in the license file.
Feature:

gateway

Hostid:

UG_HWKEY_ID=13625

License path:

28000@server1

FLEXnet Licensing error:

-9,333

In addition, the debug log (splm_ugslmd.log) will contain errors like the following:
DENIED:

“gateway”

fred@barney

DENIED:

“gateway”

fred@barney

(INVALID error code
(Invalid host.

(-9999,333)

(-9,333)

In these cases, check the following:
•

Make sure the Hardware Key is plugged in securely.

•

Make sure that the Siemens PLM Software license file has the same number in the UG_HWKEY_ID field
that is printed on the Hardware Key itself.

•

Check the status of the Sentinel driver:
•

For a Parallel Port hardware key, make sure that the “Sentinel” Windows device driver appears in
Device Manager and is in its Started state
Control Panel→System→Hardware→Device Manager→View→Show Hidden Devices→Non-plug and
Play Drivers→Sentinel (double-click)

•

For a USB hardware key, make sure that Device Manager shows an entry for Rainbow USB SuperPro key.
Control Panel→Device Manager→Universal Serial Bus Controllers→Rainbow USB SuperPro
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•

If the Sentinel driver is missing, manually install it:
•

On the license server, the Sentinel driver installation file can be found in the following (default)
installation path:
C:\Program Files\Siemens\PLMLicenseServer\Hardware_Key\Sentinel System Driver Installer
7.5.7.exe

•

On the NX client, the Sentinel driver installation file can be found in the following (default) installation
path:
C:\Program Files\Siemens\NX\UGFLEXLM\sentinel_installer.exe

Error Handling Failed – NX Initialization error
This error may occur due to several reasons:

Check that the real hostname of the license server is on the SERVER line of the license file. The
license file is electronically provided by Siemens PLM Software with 'YourHostname' or 'this_host'
on the SERVER line as a placeholder for the real hostname of the license server. The SPLM
Licensing installation will edit the license file to automatically change "YourHostname" or
"this_host" keyword to the actual hostname of the license server. However, this field must be
edited manually for any subsequent updates of the license file and for redundant server
configurations (i.e. license files containing 3 SERVER lines).
Check that the SPLM_LICENSE_SERVER environment variable is set to a valid Standalone Node-Locked
License file or '<port>@<hostname>', where the port and hostname come from the SERVER line in the
license file. The SPLM_LICENSE_SERVER variable is normally set during the installation of NX but can be
manually set using the Control Panel→System→Advanced system settings→Advanced
tab→Environment Variables... button user interface.
This error may also be caused by selecting too few colors in Control Panel→Display→Settings tab. NX will
not run if the color palette is only set to 256 colors or if the resolution is below 1024x768.
Check the NX syslog file in your %TEMP% directory for other possible errors.

NX Startup Very Slow
Slow startup of NX can be caused by a slow network connection between the client(s) and license server.
If NX and the SPLM License Server are running on the same computer, then slow startup may also be a
result of a missing entry in your hosts file.
To correct this, find the “hosts” file in your Windows folder and edit it to add a new entry that consists of
an IP address (of the form xxx.xxx.xxx.xxx) and the computer’s hostname. For example: 198.168.0.1
mycomputer.
The hosts file is located at:
C:\WINDOWS\system32\drivers\etc\hosts

33

Tools->Spreadsheet does not start Excel
To start Excel, the spreadsheet tool uses DLLs which are registered on the local workstation during the installation
process (regular or mapped drive installations). If Excel does not start when you use the spreadsheet tool, verify that
the DLLs are registered on the local workstation.
In regedit, the DLLs are registered in the registry hives:
HKEY_CLASSES_ROOT\CLSID\{D99CD578-9510-4014-9161-F01778698159}
HKEY_CLASSES_ROOT\Wow6432Node\CLSID\{D99CD578-9510-4014-9161-F01778698159}
If these hives don’t exist you can register the DLLs using a script in the INSTALL kit of the installation. Run the
INSTALL\register_splm_files.bat script to register the DLLs.
Note: These DLLs use the .NET 4.6.1 Framework so that version or a newer one is required to be installed on
the local workstation to register the DLLs. The .NET 4.6.1 Framework is installed by the setup.exe
program if it, or a newer version, doesn’t exist on the local workstation during product installation.

Part Preview Issues
Part file preview in Windows Explorer and the ability to launch NX by double-clicking on a part file are
managed by ugshext.dll. Registry entries are created during regular and mapped drive installations to allow
the part icon to appear in Windows Explorer and for double-click open in NX to function after installation. Part
file preview is not configured during installation.

To allow part file preview to function in Windows Explorer, additional registry entries need to be created. If
you would like to use the part file preview functionality, you will need to register the ugshext.dll on the local
workstation.
Note: The file location stored in the registry will be for the last version of ugshext.dll registered. If an older
version of ugshext.dll is registered after a newer version, the older version ugshext.dll will be used for
part file preview. Due to differences in the DLL functionality between versions, this could mean the
part preview on newer parts may not work properly when an older version of ugshext.dll is registered.
To register the ugshext.dll, do the following:
1. Log onto your workstation, using an account with Administrator privileges.
2. Open a command prompt window and move to the %UGII_BASE_DIR%\NXBIN folder:
cd /d %UGII_BASE_DIR%\NXBIN
3. Use regsvr32 to register the DLL:
regsvr32 ugshext.dll
If you experience errors during Windows Explorer part file preview, part file preview doesn’t appear, or
double-clicking a part file does not start NX, you may need to fix the registration of the ugshext.dll by
unregistering and re-registering ugshext.dll.
Because of the ability to install multiple older versions of NX on a system, it is possible when a version is
uninstalled that it will remove settings for the ugshext.dll in the registry. If you remove the last or only version
of NX installed on the machine and you have manually registered the ugshext.dll or if you remove one version
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of NX and the remaining version was not the one registered you will want to unregister and then, if still
needed, re-register the appropriate ugshext.dll version for continued Windows Explorer extensions support.
To unregister ugshext.dll, do the following:
1. Log onto your workstation, using an account with Administrator privileges.
2. Open a command prompt window and move to the %UGII_BASE_DIR%\NXBIN folder:
cd /d %UGII_BASE_DIR%\NXBIN
3. Use regsvr32 to register the DLL:
regsvr32 /u ugshext.dll
Note: The DLL location stored in the registry will be for the last version of ugshext.dll registered. If an older
version of ugshext.dll is registered after a newer version, the older version ugshext.dll will be used for
part preview. Due to differences in the DLL functionality between versions, this could mean the part
preview on newer parts may not work properly when an older version of ugshext.dll is registered.
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